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Introduction

By taking advantage of the Oracle Metadata Services (MDS) framework, Oracle
WebCenter enables you to create rich, customizable applications and tailor them to the
needs of your organization. You can customize the task flows associated with Oracle
WebCenter ‘s Social Computing Services and WebCenter Spaces.You customize task
flows in JDeveloper and then apply the customizations to a running WebCenter
application..

Oracle WebCenter supports several levels of customizations:

« Seeded customization, which application developers perform at design time. Seeded
customizations stay with the application for the duration of the application’s
deployment.

« User customization, which allows an end user to change the content of the application
at runtime to suit individual preferences (for example, the specific columns that should
be visible in a table), and have those changes "remembered" the next time the user
opens the application.

« Design time at runtime, which enables different roles to perform various customizations
during the runtime of the application. Oracle WebCenter supports this capability by
integrating with Oracle Composer.
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WebCenter task flow customization is an example of a seeded customization. As an
application developer, you customize the task flows for your organization’s needs in
JDeveloper, and apply them to the deployed application. These seeded customizations
then remain in effect for the duration of its deployment.

Oracle WebCenter makes it easy for you to perform and apply task flow customizations.
Since the Oracle WebCenter Framework design time experience is provided as an
extension to Oracle JDeveloper 119, you can take advantage of JDeveloper roles that
scope the development environment for a particular task. One of these roles is the
“Customization Developer” role, which helps you customize the metadata of your
application with minimal coding. For more information on customizing a custom
WebCenter application’s metadata, refer to Chapter 5, “Extending Runtime Editing
Capabilities Using Oracle Composer” in Oracle Fusion Middleware Developer's Guide for
Oracle WebCenter for more details.

WebCenter’s Social Computing Services and WebCenter Spaces expose their common
functionalities using task flows. By using JDeveloper’s Customization Developer role, you
can customize WebCenter task flows to extend or alter the out-of-the-box look and feel
and functionality of these task flows.

You can learn more about the types of customization in the Oracle Fusion Middleware
Developer’s Guide for Oracle Application Development Framework. To learn more about
Oracle WebCenter and WebCenter Web 2.0 Services, see the Oracle Fusion Middleware
Developer’s Guide for Oracle WebCenter. Both of these guides are available in the
Oracle Fusion Middleware Documentation Library 11g Release 1 (11.1.1) on the Oracle
Technology Network (http://download.oracle.com/docs/cd/E12839 01/index.htm).



http://download.oracle.com/docs/cd/E12839_01/cross.htm
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The WebCenter Task Flow Customization Process

In Oracle WebCenter 11g Release 1, you can perform View-level customization on your
WebCenter applications, such as changing the look and feel of the task flow, adding ADF user
interface (Ul) components on a task flow page, or deleting Ul components from a task flow page
(fragment.) All JSPX customization is possible; ADF model or controller customizations ate not
currently supported.

This whitepaper covers the following steps to prepate a customizable WebCenter application and
customize WebCenter task flows:

1. Create a WebCenter application

2. Create the customization classes

3. Make the customization classes Available to JDeveloper

4. Enable seeded customizations for the View project in your WebCenter application

5. Configure the design time customization layers for JDeveloper

6. Configure the WebCenter application’s adf-config.xml file for customization

7. (Optional) Making WebCenter Spaces task flow libraries available to a WebCenter application

8. Restart JDeveloper in the Customization Developer Role

The following diagram shows the process for customizing WebCenter task flows.



Oracle White Paper—WebCenter Task Flow Customization

Add the WebCenter

Run Create WebCenter Services or
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Figure 1. Customizing WebCenter Task Flows

Note: When you apply task flow seeded customizations to a deployed WebCenter application,
the customizations apply to all instances of the task flow across the application, eliminating the
need to repeat customizations for a particular task flow on every page that contains the task flow.
You can enable task flow customization in a custom WebCenter application or in WebCenter

Spaces.
Preparing a Customizable WebCenter Application

To customize the task flows in your WebCenter application, first ensure that you have a custom
WebCenter application (that is, an application you’ve created using the WebCenter Application
template). You can also create a new one for the purposes of following these steps. To do so, in
JDevelopet, open the New Gallery, choose Applications, then choose WebCenter Application.
For the purposes of this document, name your sample WebCenter application
“SampleWebCenterApplication.”

Create the Customization Classes

Once you have created a WebCenter application, you must make the customization classes that
you want to use in your application. A customization class is the interface that MDS uses to
define which customization applies to the base definition metadata. Each customization class

defines a customization layer and can contain multiple layer values.

To create customization classes for a custom WebCenter application:
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In the Application Navigator, select the application’s ViewController project, then
choose File > New.

In the New Gallery, choose the Java category, and then choose Java Class from the
Ttems list.

In the Create Java Class dialog, create a new Java class named “WCSiteCC” that extends

the oracle.mds.cust.CustomizationClass and click OK.

Create Java Class [z|

Enter the details of yvour new class,

Mame:  |WCSiteCC |

Package: | i | L:'k

Extends: |-:ura-:le.mu:ls.-:ust.Custu:umizatiu:unCIass| | '%

Cptional Atkributes

Implements; I% x

Access Modifiers Other Modifiers
(%) public (3 =Mone:=
() package protected (") abstract
(1 Final
Constructars from Superclass
Implement Abstract Methods
[ ] Main Methad
| Help | (] 4 _‘ | Cancel

Figure 2. Creating a Java Class
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4. In the Source code of the WCSiteCC.java file, replace the code with the following:

Code Listing 1: WCSiteCC.java Code

package view;

import java.io.lOException;
import java.io.lnputStream;

import java.util_Properties;

import oracle.mds.core_MetadataObject;
import oracle.mds.core.RestrictedSession;
import oracle.mds.cust.CacheHint;

import oracle.mds.cust.CustomizationClass;

public class WCSiteCC extends CustomizationClass {
private static final String DEFAULT_LAYER_NAME = “site”;
private String mLayerName = DEFAULT LAYER_NAME;

public WCSiteCC(Q) {
}

public WCSiteCC(String layerName) {
mLayerName = layerName;
}

public CacheHint getCacheHint() {
return CacheHint.ALL_ USERS;
}

public String getName() {
return mLayerName;
}

public String[] getValue(RestrictedSession sess,
MetadataObject mo) {
return new String[] {“webcenter’};

}

Note: The example code uses a customization layer “site” with the value “webcenter”. For
more details on CustomizationClass, refer to Chapter 5, “Extending Runtime Editing
Capabilities Using Oracle Composet” in the Oracle Fusion Middleware Developer's Guide for Oracle
WebCenter.

5. Rebuild the ViewController project by right-clicking ViewController in the Application
Navigator, and choosing Rebuild ViewController.jpr.
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Make the Customization Classes Available to JDeveloper

After you create the customization classes, you must make them available to JDeveloper so that
you can use them when implementing customizations. When working in JDeveloper
Customization Developer role, yout customization classes must be available in JDeveloper IDE's

classpath.
To include the customization classes in your application:

1. In the Application Navigator, right-click the ViewController project for your application and
choose Project Propetties.

2. In the Project Properties dialog, click Deployment, then click New.

3. In the Create Deployment Profile dialog, name the new JAR file myCCjar, then click OK.

® Create Deployment Profile

Click Ok ko create vour new deployment prafile and immediately open it to see its configuration,

archive Type:
| J4R File |

Marne:

|myCCjar| |

Descripkion:

Creates a profile For deploying a simple archive to the file system, The 1R file consists of & JAR or
ZIP file,

Help [ O j | Cancel ]

Figure 3. Creating a Deployment Profile

4. On the JAR Options page, edit the JAR profile, enter the following location for the JAR file:

JDEV_HOME/ jdev/lib/patches/myCC. jar

Note: JDEV_HOME is the name of the directory where JDeveloper was installed.
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5. Select Filters on the left and add the WCSiteCC class to the JAR file.

Edit JAR Deployment Profile Properties

(@8 )| Filters
= JAR Options Files | Patterns
[ File Groups
i EI Project Output This file group includes the project output directory as a contributor. You may
______ . T— need to compile the project to see all files coming from the output directory.
£ E}--- ca Merged Contents of Thiz File Group's Contributars
‘- Profile Dependencies B3 data
. @-[]£3 noonnnan
E} £ wiew
i e[V [ wesitecCoclass
s |:| @ YiewZontraller.cdi
Expand All Modes | Collapse All Modes |

|m [ 914 J I Cancel |

Figure 4. Adding the WCSiteCC Class to the Deployment Profile

6. Click OK and then click OK again.

Save your files.

8. In the Application Navigator, right-click the ViewController project and choose Deploy >
myCCjar > To Jar file to deploy the JAR.

~

Enable Seeded Customizations for View Projects in WebCenter Applications

Once you make the customization classes available to your WebCenter application, you must

enable the seeded customizations for the application’s View project.

To enable seeded customizations in your application:
1. In the Application Navigator, right-click the ViewController project, and choose Project
Properties.

2. In the Project Properties dialog, select ADF View, then select the Enable Seeded

Customizations checkbox.
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3 Project Properties - C:\JDeveloperimywork\SampleWebCenterApplication\ViewController\WiewControl... E|

ADF Yiew

Pr-ojec.t.Sourcé Paths | () Use Custom Settings
ADF Model

ADF Yiew
- Ank
S Blisiness Campanents When ADF Faces is present, J5F HTML widgets will nok show when dropping datacontrals,

() Use Project Settings

i Compiler
Dependencies
Deployment
EJE Module
Extension [] Enable User Custamizations
Javadoc :
Java EE Application 155 SEselons L
J5P Tag Libraries Enahble Seeded Customizations
J5P Visual Editor
Libraries and Classpath
Resource Bundle
Fun/Debug/Profile

- Technology Scope

[ Include J5F HTML Widgets

Configure customization options For ADF Faces,

| Help | Ok J | Cancel

Figure 5. Enabling Seeded Customizations

3. Click OK and save your files.

Configure the Design Time Customization Layers for JDeveloper

To enable customization of WebCenter task flows at design time, you must configure the CC
layer values that you want to use in the JDeveloper Customization Developer role. In your file
system directory, in JDEV_HOME/ jdev, open the CustomizationLayerValues.xml
and configure the CC layer values.

In the following example, the “size”” Layer is configured with the value “webcenter” for the

JDeveloper Customization Developer role.

Code Listing 2: Customization Layer

<cust-layers xmlns="http://xmIns.oracle.com/mds/dt">
<cust-layer name="site" i1d-prefix="s">
<cust-layer-value value="webcenter" display-
name="WebCenter"/>
</cust-layer>
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| </cust-layers>

Configure Your Application’s adf-config.xml File

The application's adf-config.xml file must have an appropriate cust-config element in

the mds-conFig section. The cust-config element allows clients to define an ordered and

named list of customization classes. You can use the ovetview editor for the adF-config.xml
file to add customization classes.

To configure the adF-config.xml file:
1. In the Application Resources panel, under Descriptors > ADF META-INF, open the adf-
config.xml. Before you make any changes to the code, back up the adf-config.xml file.

2. In the Overview editor, select MDS Configuration.

3. Add the WCSiteCC class to the file to generate MDS custom configuration.

10
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E adf-config.xml | (=]
MDS Configuration (&) Mate that additional configurations can be edited manually in the source.
Tag Configuration
[=] Customization Configuration: Match Path ="/ = X
Use the Following editor For cases where the customization configuration map to the
global namespace (™.
Cusktomization Classes
4
h 4
4
| Overview | Source | Histary | © » [

Figure 6. Adding the WCSiteCC to the adf-config.xml File

Save all your files.

The source code of the adf-config.xml file should now contain a reference to the new

customization class, view.WCSite CC.

Code Listing 3: Customization Class Order in the adf-config.xml File

<adf-config xmlns="http://xmlns.oracle.com/adf/config">
xmIns=""http://xmlns.oracle.com/adf/mds/config">

version=""11.1.1.000">

<adf-mds-config
<mds-config xmlns="http://xmlns.oracle.com/mds/config"

<cust-config>
<match path="/">

11
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<customization-class name="view.WCSiteCC"/>
</match>

</cust-config>
</mds-config>
</adf-mds-config>
</adf-config>

Make WebCenter Spaces Task Flow Libraries Available to Your Application

To allow customization of WebCenter Spaces task flows, you must perform a few configuration
steps to set up the JDeveloper workspace to allow customization of WebCenter Spaces task
flows. You only need to perform these steps once. If you are not customizing WebCenter Spaces
task flows, you can skip to the next section, “Restart JDeveloper in the Customization Developer
Role and Verify the Configuration.”

To customize WebCenter Spaces task flows, you need to include the WebCenter Spaces View
JAR file in your project. The WebCenter View jar (webcenter-app-view. jar) is packaged
and shipped with WebCenter Spaces, and is located here:

FMW_HOME/ZIlib/java/internal/oracle.webcenter.spaces/11.1.1.0.0/web
center-app-view. jar

Note: FMW_HOME is the name of the directory where WebCenter Spaces was installed.

Oracle WebCenter Social Computing Services’ task flows, such as the Discussion Forum and
Mail task flows, are part of the WebCenter Extension and are available in the Task Flows folder
in the WebCenter Services Catalog, located in the Resource Palette in JDeveloper.

To set up JDeveloper for WebCenter Spaces task flow customization:
1. In the Application Navigator, right-click the ViewController project for your WebCenter

application and choose Project Properties.

2. In the Project Properties dialog, select Libraries & Classpath and click “Add JAR
/Directory....” button

12
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Figure 7: Making Webcenter Spaces’ task flow libraries available to the application

3. Navigate to the Oracle WebCenter Spaces installation directory and select webcenter-app-

view.jar.
4. Click Select.
5. Click OK.

13
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@ Add Archive or Directory

Location: |1 fscratchinbshah fview storage/nbshah_rl_jps/oraclefasllgriveflibfjavas.. = ﬁ

Alk e

417 api
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é = D oraclewebcenter.spaces
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Wark +-F] invite-proxy jar
+-37 message-proxy jar
@ +-#] spaces-apijar
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Home +-#1 subscribe-proxy jar
433 unzubzcribe-proxy jar
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el ebcenter-app- F
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+ r_—| mds
Directory name:;
Help select Cancel

Figure 8: Add webcenter-app-view.jar as a Classpath entry
6. Save your files.

7. In the Application Navigator, next to the Projects dropdown list, click the Navigator Display

Options icon and select Show Libraries.

14



Oracle White Paper—WebCenter Task Flow Customization

nppllcatmn Mavigator |

)

. SampIeWebCenter.ﬁ.ppllcatlnn

= Projects
Model
=[] ViewZontroller
=[] Application Sources
LB L@ wigw
i, HEH @ WiCSiteCC java
E| {7 Web Content
E| D WEB-INF
: L_|El adfc-config.xml
. faces-canfig.xml
------- E trinidad-config. xml

I 71 Page Flows

Application Resources
[+ Data Controls
[+ Recently Opened Files

B8R V-

Graup by Direckary:
Sort by Twpe

Package Level b
Web Content Level b
Show Libraries

v Group by Category
v Group Related Files

Figure 9. Displaying the Oracle WebCenter Task Flow Libraries in the

8. Save all your files.

Application Navigator

Restart JDeveloper in the Customization Developer Role and Verify the

Configuration

After you’ve enabled customization for your application, you can switch to the Customization

Developer role and begin customizing your task flows.

To switch to the Customization Developer role:

15



Oracle White Paper—WebCenter Task Flow Customization

1. In]Developer, choose Tools >Preferences > Roles, select Customization Developer
role, and then click OK.

1‘-‘! Preferences

(@8 cear )| Roles
- Debugger ~|| Role:

- Deployment ) pefault Role
- Diagrams

Enables all kechnologies.

- Extensions =

- File Types (#) Customization Developer

- Global Ignare List Configures the product For customizing metadata

- Hikp Analyzer (") Database Edition

 Https and Truststore Settin Includes only Features For core database development.
- Javascript Editor — -

- Java Wisual Editor () Java EE Edition

- I5F and HTML Yisual Editar Includes only Features For core Java EE development,

- Mobile () Java Edition

Includes only Features for core Java development,

-~ Run
- Shartout keys

- Tasks

- TapLink

- Yersioning

- \ieb Browser and Proxy
- WS- Testing Tools

- WS Policy Store

~ ¥ML Schemas
; 5 Blways prampt Faor rale selection on skartup

Help | | Ok J | Cancel

2. Figure 10. Selecting the Customization Developer Role

3. JDeveloper prompts you to restart. Choose Yes to restart JDeveloper in the

Customization Developer Role.

4. In JDeveloper, in the Customization Developer role, you see a Customization Context
window with the Edit with following Customization Context radio button selected and
customization layer name selected as “site” and “webcenter” as the layer value. If you
see that means that you have successfully configured your

SampleWebCenterApplication to enable customization of Oracle WebCenter task flows.

16



Oracle White Paper—WebCenter Task Flow Customization

Applicationld - Customization Context
) Wiewwithout Customizations

) Edit with following Customization Context

Tip layer Mame Walue
site Webcenter (nebcenter)

Customization Context : site f webcenter

Figure 11. Customization Context

Customizing WebCenter Task Flows

Out of the box, WebCenter Social Computing Services and WebCenter Spaces have well-defined
user interfaces and behavior. One of the features that Oracle JDeveloper includes to help you do
this is the Customization Developer role.

JDevelopet’s Customization Developer role is a powerful mechanism that allows you to
customize the ADF Library without changing the code in the baselibrary JAR. Since both Oracle
WebCenter and Oracle ADF are leverage MDS, you can use the Customization Role to extend
WebCenter Spaces and WebCenter Services task flows. All WebCenter task flows are packaged in
the ADF Library so task flow customization is possible in JDeveloper design time.

The SampleWebCenterApplication is built on WebCenter technology and already contains some
WebCenter Service task flow libraries, which you can see in the Application Navigator. You can
see all WebCenter Service task flows under the Resource Palette and add them to this sample
application. Any task flow ADF libraries that you add display in the Application Navigator.

The following are four use cases that demonstrate WebCenter task flow customization using the
JDeveloper Customization Developer role.

o Use Case 1: In WebCenter Spaces, add a link to the WebCenter Spaces Global ToolBar task
flow

o Use Case 2: In WebCenter Spaces, modify the label in the WebCenter Spaces Global ToolBar
task flow

o Use Case 3: In WebCenter Spaces, remove the primary tabs from the WebCenter Spaces Local
ToolBar task flow

17
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o Use Case 4: In a WebCenter application (a custom WebCenter application or WebCenter
Spaces), customize the WebCenter Discussion Forums task flow to show an image next to the

authot’s name.

Use Case 1: (WebCenter Spaces) Adding a Link to the WebCenter Spaces
Global Toolbar Task Flow

This example shows how to add a link to the WebCenter Spaces toolbar. The following image
shows the various links that display: Group Spaces, Favorites, Preferences, and so on. This

toolbar is a rendered view of the Global Toolbar task flow.

Friadriir Group Spaces ¥ Favorites ~ Preferences Help  Logout o

[ Page actions + Tags () Links
Figure 12. Global Toolbar Task Flow in WebCenter Spaces

Before you can perform these steps, ensure that you have set up JDeveloper to enable
WebCenter Spaces task flow customization, as previously desctibed in this document.

To add a link to the WebCenter Spaces Global Toolbar task flow:

1. Ensure that the WebCenter application is open in JDeveloper and that you atre using the
Customization Developer role.

2. In the Application Navigator, expand the ViewController project, and navigate to
webcenter-app-view.jar (added eatlier in the section “Making WebCenter Spaces Task Flow
libraries available to Application”).

3. Navigate to oracle.webCenter.webCenterapp.view.taskflows.globalToolbar.

18
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Figure 13. Global Toolbar Task Flow in the Application Navigator

4. Under globalToolbar, select BoilerPlate.jspx and open it.
5. Look for the af:zcommandLink tag with the id “profileLink”.

Code Listing 4. af:commandLink in the BoilerPlate.jspx file

<af:commandLink text="#{security.userDisplayName}"
actionListener="#{backing_wc_resourceHandler.resourceActioned}"
id="profileLink™ inlineStyle="white-space:nowrap"
partialSubmit=""true" rendered="#{security.authenticated}"

</af:commandLink>

6. In the Design view, insert an <afigoLink > component after it. Set a link, such as
“http://www.example.com/support/welcome.html” as the destination for the
newly inserted goLink component.

These steps created the necessary customization for BoilerPlate.jspx under

Application_Directory/ViewController/libraryCustomizations/
oracle/WebCenter/WebCenterapp/view/task flows/globalToolbar.

19
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The resulting toolbar looks like this:

Friswadmin | Example.com | Group Spaces v Favorites + Preferences | Help Logout O

i]E Fage Actions = _ Tags @ Links
Figure 14. Updated Global Toolbar Task Flow Label in WebCenter Spaces

Use Case 2: (WebCenter Spaces) Modify the Label in the WebCenter Spaces
Global Toolbar Task Flow

This example shows how to change the text label in the Global Toolbar task flow. In WebCenter
Spaces, the top left corner of the page displays as follows:

ORACLE WebCenter Spaces fmwadmin

Figure 15. Global Toolbar Task Flow Label in WebCenter Spaces

Here, the text in the global toolbar says “WebCenter Spaces.” You can change this text to match
your organization’s name of, for example, “WebCenter Groups.”

Before you can perform these steps, ensure that you have set up JDeveloper to enable
WebCenter Spaces task flow customization, as described in the section, “Make Oracle
WebCenter Spaces Task Flow Libraries Available to Your Application.”

To change the label in the WebCenter Spaces Global Toolbar task flow:

1. Ensure that the WebCenter Spaces application is open in JDeveloper and that you are using
the Customization Developer role.

2. In the Application Navigator, expand the ViewController project, and navigate to
webcenter-app-view.jar.

3. Navigate to oracle.WebCenter.WebCenterapp.view.taskflows.globalToolbar.

Under globalToolbar, select BoilerPlate.jspx and open it.

5. In the Structure Window, select the af:outputText component with the ID ” gtbpot1” under
the ineerStart facet.

>

Code Listing 5: af:outputText component

<af:outputText
value="#{WCAppContext.application.applicationConfig.title}"
styleClass="AFBrandingBarTitle" i1d=""gtbpotl'/>

6. In the Property Inspector, next to the Value property, click the arrow and click Select Text
Resource.

7. In the Select Text Resource dialog, enter a display value of WebCenter Groups and set the
ID to WebCenter Groups.

20
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8. Click Save and Select to create an override bundle with a resource key at the application
level. If you are performing this action for the first time, a confirmation dialog displays.

= Select Text Resource ||§||E|

Rezource Bundle: |YiewControllerBundle ‘ri

Enter the Dizplay Yalue for your text rezource and the selected bundle will be
searched automatically for matches. Ifyoudo not select a matching resource a new
one will be created.

Display Value:
Bl @ Confirm override
You are about to add key WEECEMTER_CROUP to the
1 owerride bundle. Continue?
Key: -
WER :
l: [ | 5kip This Message Mext Time :I
Desc
es || Mo |
Matching Text Resources: Clear Selection

Mo matching text resources exist

Help | | Save and Select J | Cancel

Figure 16. Confirming the Override of the Resource Bundle

9. Click Yes, then click Save and Select.

Notice that the customization file, GlobalToolbar.jspx.xml, is automatically created under the

libraryCustomization folder in the ViewController project with following contents:
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Code Listing 6. GlobalToolbar.jspx.xml Contents

<mds:insert
parent="(xmIns(Jsp=http://java.sun.com/JSP/Page))/jsp:root"
position="first"
xmlns:c="http://java.sun.com/jsp/jstl/core'>
<c:set xmlns:c="http://java.sun.com/jsp/jstl/core"
var="viewcontrol lerBundle"
value=""#{adfBundle["view.ViewControllerBundle®]}"/>
</mds:insert>
<mds:modify element="gtbpotl'>
<mds:attribute name="value"

value=""#{viewcontrollerBundle _WEBCENTER_GROUPS}"/>
</mds:modify>

This file defines a new Override Resource Bundle in the application’s adf-config.xml file.

Code Listing 7. Updated adf-config.xml File

<adf-resourcebundle-config
xmIns="http://xmlns.oracle.com/adf/resourcebundle/config">
<applicationBundleName>

resourcebundles/xliffBundles/SampleWebCenterApplicationOverrideBundle
</applicationBundleName>
<bundleList>
<bundleld override=""true'>
view._.ViewControllerBundle
</bundleld>
</bundleList>
</adf-resourcebundle-config>

In your file system, in the application’s directory, you can also see the application level override
resource bundle being created. This resource bundle will contain the new keys that you define in
JDeveloper Customization Developer role.

For example:
Application_Directory/resourcebundles/xliffBundles/SampleWebCente
rApplicationOverrideBundle.xIf

The resulting toolbar looks as follows:

ORACLE WebCenter Groups

Personal Space ™
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Figure 17. Global Toolbar Task Flow Label in WebCenter Spaces

Use Case 3: (WebCenter Spaces) Removing Primary Tabs from the Local
Toolbar Task Flow

In WebCenter Spaces, group space navigation is performed through tabs and menus. You can
modify the application to show group space navigation only through menu items by customizing
the Local Toolbar task flow.

ORACLE WebCenter Groups

My Group Spaces ExampleGs
Home ¥  Documents  Discussions  Announcements | Lists | Events | Settings
Figure 18. Local Toolbar Task Flow in WebCenter Spaces

Before you perform these steps, ensure that you have set up JDeveloper to enable WebCenter

Spaces task flow customization, as previously described in this document.

To remove primary tabs from the WebCenter Spaces Local Toolbar task flow:

1. Ensure that the WebCenter Spaces application is open in JDeveloper and that you are using
the Customization Developer role.

2. In the Application Navigator, expand the ViewController project, and navigate to
webcenter-app-view jaf.
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3. Navigate to oracle.WebCenter.WebCenterapp.view.taskflows.localToolbar.

“ Projects Gl @ - 3=

Elrﬁ oraclesebcentermebcenterapp

-l bindings

[l config

[l internal

- jsLibs

@ perf

-l perftest

[ test

[ utils

[0 wiew

-Ifll component

il page

[0l pageflows

@@ pages

I zhell

[0 taskflows

-l about

<[l admin

~[[{ll applicationFooter

~[{ll applinks

S contactAdmin

S empty Content

- general

-l globalToolbar

~[[{ll languageselectar

<[l lifecycle

Siii'flocalToolbar
H-il spaceViewtaximized

Figure 19. Local Toolbar Task Flow in the Application Navigator

4. Under localToolbar, select LocalBoilerPlate.jspx and open it.

5. In the Structure window, select the wcNavigationPane component with
id=""primaryTabSet.”

6. Delete this comment by pressing the Delete key on your keyboard.

These steps created the necessary customization for LocalBoilerPlate.jspx under
Application_Directory/ViewController/libraryCustomizations/
oracle/WebCenter/WebCenterapp/view/task flows/localToolbar for
BoilerPlate.jspx.
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Note: Application_Directory is the name of directory where the JDeveloper application was
created.

The resulting toolbar looks as follows:

ORACLE WebCenter Groups

Home ™ | Documents | Discussions | Announcements  Lists  Events | Settings

Figure 20. Resulting Toolbar

Use Case 4: Customizing the Discussion Forums Task Flow

This example shows how you can customize the Discussion Forums task flow to display a profile
image for the user who initiated the discussion. The following is a sample Discussion Forum
without the profile image.

Home Discussions ¥  Announcements  Lists | Events  Settings
Forum:Pankaj_Project

Pankaj_Project

Eﬁ' Create Topic

Taopic
Customization Topic
orcladmin

Figure 21. Discussion Forum

Before you perform these steps, ensure that you have prepared a customizable WebCenter

application.

To customize the Discussion Forums task flow:

1. In the Resource Palette, under My Catalogs, expand the WebCenter Services Catalog, and
open the Task Flows folder.

2. Right-click Discussion Forums and choose Add to project. 1f a confirmation dialog displays,
click Add Library.

3. In the Application Navigator, expand the ViewController project to view the WebCenter
Discussion Services library.
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®

10.
11.

m ADF Faces Databhinding Runtime
Er'J I'_'__‘I Webcenter-app-wiew jar
=- ﬂ WebCenter Discussion Services YWiew
E—'I"Jﬁ] oraclemebcenter.collab
-l forum
Er]l‘ﬁI] internal
B0 wiew
=@ jsf
=1l fragments
ConfigWienjspx
- CanfirmDeleteForum jspx
ConfirmDeleteMessage jspx

ConfirmDeleteTopic jspx
CreateiCategqory jspx
CreateFarum jspx

[ CreateTaopic jspx

Figure 22. WebCenter Discussion Services View Library in the Application Navigator

In the WebCenter Discussion Services View library, open the ListTopics.jspx file.

On your file system, in the SampleWebCenterApplication application directory, create a
directory named “images” under ViewController/public_html.

While still on your file system, in the ViewController/public_html directory, add a
few sample images in GIF format. You can name these image files as valid WebCenter
usernames, for example admin.gif, sjones._gi T, and so on. These images are the user
profile images you’ll add to the task flow.

In JDeveloper, click the Refresh icon in the toolbar of the Application Navigator.

Save the application.

If you are not already using the Customization Developer role, switch to this role (choose
Tools > Preferences, select Role, then select Customization Developer Role and restart
JDeveloper.

In JDeveloper, open the ListTopics.jspx file.

In the Structure window, search for the <rtc:presence> tag on the page. This tag renders
the username.
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(=l application Navigator E LiztTopics jspx - Structure Q
| g
] Wrarnings (1)
,—_| Copyright () 2008, 2009, Oracle andfor its affiliates. All rights reserved
& jspiroot
----@jsp:directiue.page
- [15F] f:loadBundle
}E__'d af:panel5tretchlayout

lﬂ f:facet - top

5@ f:facet - center

= artable - fLTTHI

=5 af:column
l_ﬂ ffacet - header
95 af:panelGrouplayout - wertical

EE af:panelGrouplayout

feiiioafspacer - 2

=4 af:panelCrouplay out

@ afiimage - images f#{row postedby }.gif
af:calumn

afzcalumn

.
- 5
Figure 23. rtc:presence Tag in the Structure Window

12. Right-click the rtc.:presence tag, then choose insert After > ADF Faces > Panel Group
Layout from the context menu.

13. In the Structure Window, right-click the new Panel Group Layout and choose Insert >
Image Component.

14. In the Property Inspector for the new Image component, set the Source property to
/images/#{row.postedBy}.giT. This generates the image name (which you added to
your application project) named like the user who posted the discussion.

15. Save your files and rebuild the project.

The ListTopics.jspx.xml file that is generated now contains the following code:

Code Listing 8. Updated ListTopics.jspx.xml File

<mds:customization version="11.1.1.54_.01"
xmIns:mds="http://xmlns.oracle.com/mds">
<mds:insert parent="frmltpglll"” position=""last"
xmlns:af=""http://xmIns.oracle.com/adf/faces/rich">
<af:panelGrouplLayout
xmlns:af=""http://xmIns.oracle.com/adf/faces/rich"
id="'slpgll">
<af:image xmlns:af="http://xmlns.oracle.com/adf/faces/rich"
source=""/images/#{row.postedBy}.qgif" id="slil"/>
</af:panelGrouplLayout>
</mds:insert>
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</mds:customization>

This example illustrates how you can use EL to customize a task flow in a custom WebCenter

application.

Alternatively, you could achieve the same goal in WebCenter Spaces. To do so, populate the
Image source attribute value using a managed bean. Then, use the Role APIs to retrieve the
image source from a user’s profile in LDAP. The EL in this example uses EL as part of
customization, and assumes that the profile image for the user who initiated the discussion is in
the format: <user_name>.gif. Note that the images you use must be available in the WebCenter
application’s context root, under public_html/images. When you apply the customizations, you
must package the images folder in a JAR and make it available in the WebCenter Spaces
application’s classpath. To do so, add the images JAR to the default custom shared library
custom.webcenter.spaces.war file. You can use Java’s JAR command to update the

custom.webcenter.spaces.war file. After adding the JAR, redeploy the shared library.
Cwerview  Documents  Discussions = | Tasks | Calendar | Setkings

Forum:Pankaj_Project
Pankaj_Project

LEVE' Creake Topic

Topic
Customization Topic
arcladrmin

T Image coming

PP el S,

customization

Figure 24. Discussions Forum Task Flow Rendering the User Profile Image in
WebCenter Spaces

For more information on the custom.webcenter.spaces.war file, see the “Extending
WebCenter Spaces” whitepaper on the Oracle Technology Network

(http:/ /webcenter.oracle.com).

Modifying Customizations to a Deployed WebCenter
Application

In the previous sections, we customized WebCenter task flows for four different scenarios. The
output of these exercises is the generated MDS customization. The customizations show up as
xmb.xml or . jspx.xml files in the View project of the application in the
libraryCustomization package. These customization documents are essentially instructions for
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MDS to apply delta on top of the base document that is shipped to show the customized
behavior at runtime. Once you create the customizations, you must apply them to the deployed
WebCenter application.

Applying Seeded Customizations to Deployed WebCenter Applications

To see customizations performed on Oracle WebCenter task flows in JDeveloper at runtime, you
must import these customizations to the MDS repository of the deployed WebCenter
application. Since this step updates the runtime WebCenter application metadata repository, you
should first back up the MDS schema before performing this step. Oracle also advises that you
test your customizations in a development or stage environment first.

These steps cover how to apply the seeded customizations to a deployed instance of Oracle
WebCenter Spaces. The same steps can be followed to deploy customizations to a custom
WebCenter application repository, as well.

To import design time Oracle WebCenter task flow seeded customizations to the MDS
repository:

1. While the SampleWebCenterApplication is open in JDeveloper, rebuild the ViewController
project by right-clicking ViewController and choosing Rebuild ViewController.jpz.

2. Next, create a JAR profile and package the library customizations undet the ViewController
project in the JAR archive. In the Application Navigator, these customizations display under
ADFLibraryCustomization package. On your file system, the customizations are located in
the libraryCustomization folder under ViewController.

Right-click the Model project and select New.

3. In the New Gallety, select Deployment Profiles, choose JAR File from the Items list, and

click OK to generate the JAR profile.
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Figure 25. Creating JAR File to Package the Task Flow Customizations

Create a name for the JAR file, such as SampleWebCenterApplicationCustomizations.

In the Edit JAR Deployment Profile Properties dialog, click Filters on the left, then select all
the customization documents in the ADFLibrarycustomization package, then click OK.
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Figure 26. Adding the Customization Documents to the JAR File

6. Copy this JAR file, which now contains the customizations, to the machine where the
WebCenter application is deployed.
Note: Maintain a backup of this file so that you always have a version of the customizations
for this application.

7. Extract the JAR to a temporaty directory on the machine, for example /tmp/wc-cust.

8.  Use the MDS WLST import command to import the task flow customizations to the
application’s MDS repository.

The following is an example of the command to import customizations.

Code Listing 9. Command line for Importing Customizations

wls:/weblogic/serverConfig>importMetadata(application="webcenter"”
server="srg”,

fromLocation="/tmp/wc-cust”,

docs="/**")
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For more information on MDS WLST commands, refer to the Oracle Fusion Middleware WebL ogic
Seripting Tool Command Reference on the Oracle Technology Network.

Applying Seeded Customizations for Use Case 2 “(WebCenter Spaces) Modify
the Label in the WebCenter Spaces Global Toolbar task Flow”

For Use Case 2, you must add the configuration of the override resource bundle to the adf-
config.xml in the deployed WebCenter Spaces application.

To apply the customizations for Use Case 2:
1. Open the webcenter.ear file and extract the adf-config.xml in META-INF directory.

2. Add the following entry to adf-config.xml for WebCenter Spaces:

Code Listing 10: Updating the adf-config.xml file to Apply Customizations for Use Case
2

<adf-resourcebundle-config
xmIns=""http://xmlns.oracle.com/adf/resourcebundle/config">
<applicationBundleName>

resourcebundles/xliffBundles/SampleWebCenterApplicationOverrideBu
ndle
</applicationBundleName>
<bundleList>
<bundleld override="true'>
view.ViewControllerBundle
</bundleld>
</bundleList>
</adf-resourcebundle-config>

3. Add the modified adf-config.xml file to the webcenter.ear. You can use Java’s JARcommand
to update the webcenter.eat.
4. When you’re done, redeploy the webcenter.ear file.

Note: The resource bundle generated should be made available in the WebCenter
Spaces application classpath. To do this, add the override resource bundle to the default
custom shared library custom._webcenter .war file. You can use Java’s JAR
command to update the custom.webcenter .war file. After adding the bundle,
redeploy the shared library.

5. Restart the application. You should be able to see the task flow customizations.

Removing Seeded Customizations from a Deployed WebCenter Application
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You can remove seeded customizations from a deployed WebCenter application, including
WebCenter Spaces. Once you remove the customizations from the application, the task flow
behavior or look and feel will revert back to the original deployment.

Use the MDS WLST deleteMetadata command to remove the applied customizations. The
deleteMetadata command needs to exercise with caution as incorrect use of this command

may cause the loss of metadata documents.

Code Listing 11. Command to Delete the Customization Metadata from a Deployed
WebCenter Application

deleteMetadata(application="webcenter”,server="srg”,docs="/oracle|
/webcenter/webcenterapp/view/taskflows/globalToolbar/**" ,excludeB|
aseDocs="true")

For more details on MDS WLST commands, refer to the Oracle Fusion Middleware Webl ogic
Seripting Tool Command Reference on the Oracle Technology Network.

Catalog of WebCenter Task Flows

The webcenter-app-view.jar contains all the WebCenter task flows listed in the following table.
This JAR file is located here:

FMW_HOME/lib/java/internal/oracle.webcenter.spaces/11.1.1.0.0/webcentet-app-view.jar

WEBCENTER TASK FLOWS

COMPONENT ORACLE ADF TASK FLOW
CATEGORY Ul TASK FLOW NAME JAR NAME NAME DEFINITION FILE
wpfas/modules/collaboration/announcement-
Announcements | Announcement announcement- service/view/src/web/oracle/webcenter/collab/announce
Service Configuration View view.jar announcement-config-view | ment/view/taskflows/config-view-definition.xml
wpfas/modules/collaboration/announcement-
Announcement Main announcement- service/view/src/web/oracle/webcenter/collab/announce
View view.jar announcement-main-view ment/view/taskflows/main-view-definition.xml
wpfas/modules/collaboration/announcement-
Announcement Mini announcement- service/view/src/web/oracle/webcenter/collab/announce
View view.jar announcement-mini-view ment/view/taskflows/mini-view-definition.xml
wpfas/modules/collaboration/announcement-
Announcement announcement- announcement-resource- service/view/src/web/oracle/webcenter/collab/announce
Resource View view.jar view ment/view/taskflows/announcement-view-definition.xml
wpfas/modules/collaboration/announcement-
Create a link from announcement- link-existing-view- service/view/src/web/oracle/webcenter/collab/announce
Announcement view.jar definition ment/view/taskflows/link-existing-view-definition.xml
Discussions wpfas/modules/collaboration/forum-
Service Forum Configuration | forum-view.jar forum-config-view service/view/src/web/oracle/webcenter/collab/forum/view
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/taskflows/config-task-flow.xml

Forum Link to
Existing

forum-view.jar

forum-link-existing

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

[taskflows/link-existing-task-flow.xml

Forum Link to New

forum-view.jar

forum-link-new

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view
/taskflows/link-new-task-flow.xml

Forum Main View

forum-view.jar

forum-main

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view
[taskflows/main-task-flow.xml

Forum Message
View

forum-view.jar

forum-message

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

/taskflows/message-task-flow.xml

Forum Mini View

forum-view.jar

forum-miniview

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view
/taskflows/miniview-task-flow.xml

Forum Selector

forum-view.jar

forum-picker

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

Itaskflows/forum-picker-task-flow.xml

Popular Topic

forum-view.jar

forum-popularTopic

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

/taskflows/popularTopic-task-flow.xml

Recent Topic

forum-view.jar

forum-recentTopic

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

Itaskflows/recentTopic-task-flow.xml

Forum Resource
View

forum-view.jar

forum-resource-view

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

ltaskflows/resource-view-task-flow.xml

Forum Group Space
Scoped View

forum-view.jar

forum-scope-config-view

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

[taskflows/scope-config-task-flow.xml

Most Watched Forum

forum-fview.jar

forum-watchedForum

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view
[taskflows/watchedForum-task-flow.xml

Most Watched

Topics

forum-view.jar

forum-watchedTopic

wpfas/modules/collaboration/forum-
service/view/src/web/oracle/webcenter/collab/forum/view

/taskflows/watchedTopic-task-flow.xml

Documents
Service

Document Library
Main View

doclib-service-

view.jar

doclib-document-library

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/mainView.xml

Document Library
List View

doclib-service-

view.jar

doclib-document-list-viewer

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/docListViewer.xml

34




Oracle White Paper—WebCenter Task Flow Customization

Document Picker

doclib-service-

view.jar

doclib-document-picker

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/docPicker.xml

Link Document to
Existing

doclib-service-

view.jar

doclib-link-to-existing

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/relationshipsDialog.xml

Link Document to
New

doclib-service-

view.jar

doclib-link-to-new

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/relationshipsDialog.xml

Document Properties

doclib-service-

view.jar

doclib-properties

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/properties.xml

Recent Documents
View

doclib-service-

view.jar

doclib-recent-documents

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/recentDocuments.xml

Document Version
History

doclib-service-

view.jar

doclib-version-history

wpfas/modules/doclib-
service/view/src/web/oracle/webcenter/doclib/view/jsf/tas
kflows/versionHistory.xml

Events Service

Calendar Community
Resource View

event-view.jar

calendar-

communityResourceView

wpfas/modules/collaboration/event-
service/view/src/web/oracle/webcenter/collab/calendar/vi
ewsl/jsf/search/cal_comm_search_view_task-flow-
definition.xml

Calendar Main View

event-view.jar

calendar-mainView

wpfas/modules/collaboration/event-
service/view/src/web/oracle/webcenter/collab/calendar/vi
ews/jsf/fragment/calendar_main_view_task-flow-
definition.xml

Calendar Personal
Timebar

event-view.jar

calendar-personalTimebar

wpfas/modules/collaboration/event-
service/view/src/web/oracle/webcenter/collab/calendar/vi
ewsl/jsf/fragment/calendar_timebar_task-flow-
definition.xml

Event Relationship

event-view.jar

event-relationship

wpfas/modules/collaboration/event-
service/view/src/web/oracle/webcenter/collab/calendar/vi
ews/jsf/relationship/event_relationship_task-flow-
definition.xml

adfp/modules/extapp/extapp-rt-

External oracle.extapp.view. extapp-change-password- | view/src/web/oracle/adfinternal/extapp/view/fragments/e
Applications Change Password jar taskflow xtapp-change-password-taskflow.xml
adfp/modules/extapp/extapp-rt-
Credential oracle.extapp.view. extapp-credential- view/src/web/oracle/adfinternal/extapp/view/fragments/e
Provisioning Page jar provisioning-taskflow xtapp-credential-provisioning-taskflow.xml
Instant
Messaging and wpfas/modules/collaboration/rtc-
Presence rtc-buddy-list-task-flow- service/view/src/web/oracle/webcenter/collab/rtc/view/re
Service Buddies Mini View rtc-view.jar definition sources/rtc-buddy-list-task-flow-definition.xml
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List Customization

wpfas/modules/list-
service/view/src/web/oracle/webcenter/list/view/jsf/region

Lists Service View list-service-view.jar list-cust-task-flow s/list-cust-task-flow.xml
wpfas/modules/list-
service/view/src/web/oracle/webcenter/list/viewl/jsf/region
Edit List View list-service-view.jar list-edit-task-flow s/list-edit-task-flow.xml

List Instance View

list-service-view.jar

list-instance-view-task-

flow

wpfas/modules/list-
service/view/src/web/oracle/webcenter/list/view/jsf/region
s/list-instance-view-task-flow.xml

List Main View

list-service-view.jar

main-view-task-flow

wpfas/modules/list-
service/view/src/web/oracle/webcenter/list/viewl/jsf/region
s/main-view-task-flow.xml

Mail Service

Mail DL
Configuration View

mail-view.jar

dl-config-view

wpfas/modules/collaboration/mail-service/view-
new/src/web/oracle/webcenter/collab/mail/view/jsf/region
s/dI-config-definition.xml

Mail Compose View

mail-view.jar

mail-compose-view

wpfas/modules/collaboration/mail-service/view-
new/src/web/oracle/webcenter/collab/mail/view/jsf/region
s/lcompose-task-flow.xml

Mail Content View

mail-view.jar

mail-content-view

wpfas/modules/collaboration/mail-service/view-
new/src/web/oracle/webcenter/collab/mail/view/jsf/region
s/content-view-definition.xml

Mail Mini View

mail-view.jar

mail-mini-view

wpfas/modules/collaboration/mail-service/view-
new/src/web/oracle/webcenter/collab/mail/view/jsf/region
s/mini-view-definition.xml

Mail Preference View

mail-view.jar

preference-view

wpfas/modules/collaboration/mail-service/view-
new/src/web/oracle/webcenter/collab/mail/view/jsf/region
s/preference-task-flow.xml

Notes Mini View

notev.jar

note-miniview

wpfas/modules/note-
service/view/src/web/oracle/webcenter/note/view/jsf/regi
ons/note-miniview.xml

Notes

notev.jar

notes

wpfas/modules/note-
servicel/view/src/web/oracle/webcenter/note/view/jsf/regi
ons/notes.xml

View Notes

notev.jar

view-note

wpfas/modules/note-
service/view/src/web/oracle/webcenter/note/viewljsf/regi
ons/viewnote-taskflow-definition.xml

Page Service

Property Panel

page-service-
view.jar

golink-prop-panel-
definition

wpfas/modules/page-
service/view/src/web/oracle/webcenter/page/view/jsf/frag
ments/golink-prop-panel-definition.xml

Create Page

page-service-
view.jar

page-create-page

wpfas/modules/page-
service/view/src/web/oracle/webcenter/page/view/jsf/frag
ments/page-create-page.xml

Document Property

page-service-

page-doc-prop-panel-

wpfas/modules/page-
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Panel view.jar definition service/view/src/web/oracle/webcenter/page/view/jsf/frag
ments/page-doc-prop-panel-definition.xml
wpfas/modules/page-

page-service- page-doc-sec-panel- service/view/src/web/oracle/webcenter/page/view/jsf/frag

Security Panel view.jar definition ments/page-doc-sec-panel-definition.xml

wpfas/modules/page-
page-service- page-pages-dropdown- service/view/src/web/oracle/webcenter/page/view/jsf/frag

Pages Dropdown view.jar definition ments/page-pages-dropdown-definition.xml
wpfas/modules/page-

Page Picker Panel page-service- page-picker-panel- service/view/src/web/oracle/webcenter/page/view/jsf/frag

Definition view.jar definition ments/page-picker-panel-definition.xml
wpfas/modules/page-

Property Panel page-service- page-prop-panel-param- service/view/src/web/oracle/webcenter/page/view/jsf/frag

Parameter Definition view.jar definition ments/page-prop-panel-param-definition.xml
wpfas/modules/page-

Page Security Panel page-service- page-sec-panel-param- service/view/src/web/oracle/webcenter/page/view/jsf/frag

Parameter Definition view.jar definition ments/page-sec-panel-param-definition.xml
wpfas/modules/security/peoplepicker/src/web/oracle/web

People Picker Group Picker peoplepicker.jar grouppicker center/security/grouppicker/jsf/taskflows/grouppicker.xml

User Picker

peoplepicker.jar

peoplepicker

wpfas/modules/security/peoplepicker/src/web/oracle/web
center/security/peoplepicker/jsf/taskflows/peoplepicker.x
ml

wpfas/modules/relationship-

recentactivity- service/view/src/web/oracle/webcenter/relationship/view/j
Recent Activity Link Detail Pop up service-view.jar links-detail-popup sf/resources/links-detail-popup.xml
wpfas/modules/recentactivity-
recentactivity- service/view/src/web/oracle/webcenter/recentactivity/con
Recent Activities service-view.jar recent-activities troller/taskflows/recent-activities.xml
wpfas/modules/relationship-
relationship- service/view/src/web/oracle/webcenter/relationship/view/j
Link Detail service-view.jar links-detail sf/resources/links-detail.xml
wpfas/modules/search-
search-service- service/view/src/web/oracle/webcenter/search/controller/
Search Save Search view.jar all-saved-searches taskflows/allSavedSearches.xml

Search
Customization

search-service-

view.jar

search-customize

wpfas/modules/search-
service/view/src/web/oracle/webcenter/search/controller/
taskflows/customize.xml

Search Preference

search-service-

view.jar

search-preferences

wpfas/modules/search-
service/view/src/web/oracle/webcenter/search/controller/

taskflows/preferences.xml

Search Mini View

search-service-
view.jar

search-sidebar

wpfas/modules/search-
service/view/src/web/oracle/webcenter/search/controller/
taskflows/recentSavedSearches.xml
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Search Simple View

search-service-

view.jar

search-simple-view

wpfas/modules/search-
service/view/src/web/oracle/webcenter/search/controller/

taskflows/simpleSearchResults.xml

Search Tool Bar

search-service-

view.jar

search-toolbar

wpfas/modules/search-
service/view/src/web/oracle/webcenter/search/controller/
taskflows/localToolbarSearch.xml

Search Main View

search-service-
view.jar

search-view

wpfas/modules/search-
service/view/src/web/oracle/webcenter/search/controller/

taskflows/searchResults.xml

Self

Registration

Invite User

security-view.jar

invitation-task-flow-
definition

wpfas/modules/security/view/src/web/oracle/webcenter/s
ecurity/view/selfregistration/jsf/taskflows/invitation-task-
flow-definition.xml

Self Registration

security-view.jar

selfreg-task-flow-definition

wpfas/modules/security/view/src/web/oracle/webcenter/s
ecurity/view/selfregistration/jsf/taskflows/selfreg-task-
flow-definition.xml

Tags Service

Related Resource

tagging-service-

view.jar

related-resources

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
[taskflows/related-resources.xml

Tag Center

tgging-service-

view.jar

tag-center

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
[taskflows/tag-center-task-flow.xml

Tag Center Related
Tags

tagging-service-

view.jar

tag-center-related-tags

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
/taskflows/tag-center-related-tags.xml

Tag Center Related
Users

tagging-service-

view.jar

tag-center-related-users

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
[taskflows/tag-center-related-users.xml

Tag Selection

tagging-service-
view.jar

tag-selection

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
/taskflows/tag-selection.xml

Tagging Dialog

tagging-service-

view.jar

tagging-launch-dialog

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
[taskflows/launch-dialog.xml

Tagging Mini View

tagging-service-

view.jar

tagging-miniview

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
[taskflows/tagging-miniview.xml

Tagging Personal
View

tagging-service-

view.jar

tagging-personal-view

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
/taskflows/tagging-personal-view.xml

Tagging Related
Links

tagging-service-

view.jar

tagging-related-links

wpfas/modules/tagging-
service/view/src/web/oracle/webcenter/tagging/controller
[taskflows/related-links.xml

Worklist Service

Worklist Mini View

worklist-service-ui-

worklist

wpfas/modules/wpworklist-service/worklist-service-ui-
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component-
view.jar

component/ViewController/src/web/oracle/webcenter/wor
klist/view/jsf/taskFlowDefs/worklist.xml

WebCenter Spaces Task Flows

workplace/src/apps/webcenter-app/webcenter-core-

Application Application Link webcenter-app- AppLinksManageUITaskFI webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
Navigator Manager view.jar ow skflows/applinks/AppLinksManageUITaskFlow.xml
workplace/src/apps/webcenter-app/webcenter-core-

Application Sidebar Application webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Navigator Navigator view.jar appnav-task-flow skflows/applinks/AppNavigatorRegion.xml

Collapsed View of workplace/src/apps/webcenter-app/webcenter-core-
Application Application webcenter-app- AppNavCollapsedViewTas webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
Navigator Navigator view.jar kFlow skflows/applinks/AppNavCollapsedViewTaskFlow.xml

Container Task workplace/src/apps/webcenter-app/webcenter-core-
Application Flow for Application webcenter-app- webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
Navigator Link Manager view.jar WCLinksManageUIRegion | skflows/applinks/WCLinksManageUIRegion.xml|

Group Spaces

Group Space
Administration

webcenter-app-
view.jar

CommunityAdministrationT
askFlow

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/javal/oracle/webcenter/community/view/taskfl
ows/admin/CommunityAdministrationTaskFlow.xml

workplace/src/apps/webcenter-app/webcenter-core-

Group Space webcenter-app- webapp/src/java/oracle/webcenter/community/view/taskfl
Group Spaces Browser view.jar CommunityBrowserRegion | ows/browser/CommunityBrowserRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
Group Space webcenter-app- webapp/src/javal/oracle/webcenter/community/view/taskfl
Group Spaces Switcher view.jar CommunitySwitcherRegion | ows/switcher/CommunitySwitcherRegion.xml

Create Group

webcenter-app-

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/community/view/taskfl

Group Spaces Space view.jar CreateGroupSpaceRegion | ows/manage/CreateGroupSpaceRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
Group Space webcenter-app- GroupSpaceSubscriptionT webapp/src/java/oracle/webcenter/community/view/taskfl

Group Spaces

Subscription

view.jar

askflow

ows/security/GroupSpaceSubscriptionTaskflow.xml

workplace/src/apps/webcenter-app/webcenter-core-

Template webcenter-app- SpaceTemplateManageRe | webapp/src/java/oracle/webcenter/community/view/taskfl
Group Spaces Management view.jar gion ows/manage/SpaceTemplateManageRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
Page webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Management Page Action Popup view.jar PageActionsPopupRegion | skflows/page/PageActionsPopupRegion.xml
Page Actions Menu, workplace/src/apps/webcenter-app/webcenter-core-
Page Tags, and Links on webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Management Local Toolbar view.jar PageContextLinksRegion skflows/page/PageContextLinksRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
Page webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Management Page Create view.jar PageCreationRegion skflows/page/PageCreationRegion.xml
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workplace/src/apps/webcenter-app/webcenter-core-

Page webcenter-app- webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
Management Table of Pages view.jar TableOfPagesRegion skflows/page/TableOfPagesRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Export/Import Group Space Export | view.jar ExportRegion skflows/lifecycle/Exportregion.xml

Export/Import

Group Space Import

webcenter-app-
view.jar

ImportRegion

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
skflows/lifecycle/ImportRegion.xml

WebCenter
Administration

Roles Sub Tab
(Security)

webcenter-app-

view.jar

SecurityAdministrationTask
Flow-Roles

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
skflows/admin/SecurityAdministrationTaskFlow-
Roles.xml

WebCenter
Administration

Group Spaces Tab

webcenter-app-
view.jar

WebCenterAdministrationT
askFlow-Communities

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
skflows/admin/WebCenterAdministrationTaskFlow-
Communities.xml

WebCenter
Administration

Personal Space Tab

webcenter-app-

view.jar

WebCenterAdministrationT
askFlow-MyWebCenter

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
skflows/admin/WebCenterAdministrationTaskFlow-
MyWebCenter.xml

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta

WebCenter webcenter-app- WebCenterAdministrationT | skflows/admin/WebCenterAdministrationTaskFlow-
Administration Security Tab view.jar askFlow-Security Security.xml
workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
WebCenter webcenter-app- WebCenterAdministrationT | skflows/admin/WebCenterAdministrationTaskFlow-
Administration Services Tab view.jar askFlow-Services Services.xml
workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
WebCenter webcenter-app- WebCenterAdministratorTa | skflows/admin/WebCenterAdministratorTaskFlow-
Administration Help view.jar skFlow-Help Help.xml

WebCenter
Administration

Welcome Page

webcenter-app-
view.jar

WebCenterAdministratorTa
skFlow-Primary

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
skflows/admin/WebCenterAdministratorTaskFlow-
Primary.xml

WebCenter
Administration

Members Sub Tab
(Security)

webcenter-app-

view.jar

SecurityAdministrationTask
Flow-Members

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
skflows/admin/SecurityAdministrationTaskFlow-
Members.xml

ToolBar

Global Toolbar
Normal View

webcenter-app-

view.jar

GlobalToolbarRegion

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/java/oracle/webcenter/webcenterapp/view/ta
skflows/globalToolbar/GlobalToolbarRegion.xml
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Global Toolbar in

Page Maximized

webcenter-app-

workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
skflows/globalToolbar/pageViewMaximized/GlobalToolb

ToolBar View view.jar GlobalToolbarRegion arRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
Global Toolbar in webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Spaces Maximized webcenter-app- skflows/globalToolbar/spaceViewMaximized/GlobalToolb
ToolBar View view.jar GlobalToolbarRegion arRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
ToolBar Language Selector view.jar LanguageSelectorRegion skflows/languageSelector/LanguageSelector.xml
workplace/src/apps/webcenter-app/webcenter-core-
Local Toolbar webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
ToolBar Normal View view.jar LocalToolbarRegion skflows/localToolbar/LocalToolbarRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
Local Toolbar in webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
Spaces Maximized webcenter-app- skflows/localToolbar/spaceViewMaximized/LocalToolbar
ToolBar View view.jar LocalToolbarRegion Region.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
ToolBar Secondary Tab Bar view.jar SecondaryTabBarRegion skflows/secondaryTabBar/SecondaryTabBarRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Login Login Page view.jar LoginTaskflow skflows/security/LoginTaskflow.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
About About view.jar AboutTaskFlow skflows/about/AboutTaskFlow.xml
workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
webcenter-app- PersonalizeWebCenterHel skflows/general/PersonalizeWebCenterHelpTaskFlow.x
Help Personalize Help view.jar pTaskFlow ml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Favorites Favorites view.jar FavoritesTaskFlow skflows/applinks/FavoritesTaskFlow.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Preferences Preferences Dialog view.jar preference-main-dialog skflows/preference/preference-main-dialog-definition.xml
workplace/src/apps/webcenter-app/webcenter-core-
webcenter-app- webapp/src/java/oracle/webcenter/webcenterapp/view/ta
Footer Footer Normal View | view.jar ApplicationFooterRegion skflows/applicationFooter/ApplicationFooterRegion.xml
workplace/src/apps/webcenter-app/webcenter-core-
webapp/src/javal/oracle/webcenter/webcenterapp/view/ta
Footer in Spaces webcenter-app- skflows/applicationFooter/spaceViewMaximized/Applicati
Footer Maximized View view.jar ApplicationFooterRegion onFooterRegion.xml
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Conclusion

Oracle WebCenter enables you to customize the look and feel of the default Oracle ADF task
flows provided by the WebCenter Web 2.0 Services and WebCenter Spaces. You can customize
these task flows at design time in Oracle JDeveloper and apply them to applications that are

cither in development or already deployed.

You can learn more about Oracle ADF task flow customization in Oracle Fusion Middleware
Developer’s Guide for Application Development Framework, and more about Oracle WebCenter and
WebCenter 2.0 Services in the Oracle Fusion Middleware Developer’s Guide for Oracle WebCenter.
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